Rapid-Flux-Solvent-Atmosphere method for tailoring the morphology of titania substrates over large area via direct self-assembly of block copolymers

Gianpaolo Chieffi, a Rocco Di Girolamo, b Antonio Aronne, a Pasquale Pernice, a Esther Fanelli, a Massimo Lazzari, c Claudio De Rosa, b Finizia Aureliam b

Electronic Supplementary Information

S1. Materials and methods. The PS-PEO block copolymer was purchased from Polymer Source Inc. Toluene, isopropyl alcohol (IPA), titanium tetraisopropoxide (97%, TTIP) were purchased from Aldrich. All reagents were used as received. The number average mass \(M_n\) of the BCP is 136000 g/mol (\(M_n/M_w = 1.18\), \(M_w\) being the mass average molecular mass). The BCP includes a PS amorphous block with \(M_n = 102000\) g/mol and glass transition temperature of 102 °C and a PEO semicrystalline block with \(M_n = 34000\) g/mol and melting temperature of 64 °C.

Toluene solutions 1 wt% BCP were prepared at room temperature by stirring the mixture for about 30 min to ensure complete dissolution. The solutions were filtered using 0.2 mm PTFE syringes before use. All solutions were used immediately after preparation in the successive steps of the present study. We checked that during the fast protocol adopted for preparation of the hybrid systems, the solutions containing TTIP and the BCP remained transparent, even without addition of HCl, a reagent whose role is both to act as a catalyst for the hydrolysis of TTIP and as a retardant for the condensation reactions.

Thin films of neat BCP and PS-PEO/TiO\textsubscript{x} hybrid systems, of thickness 50-100 nm, were obtained at room temperature by spin coating at 2500 rpm for 30 s, after deposition of few drops (≈ 0.2 ml) of a solution on a silicon wafer (1 cm x 1 cm) using a spin coater P6700-Specialty Coating Systems. The film thickness was measured with a DEKTAK 3 – Surface Profile Measuring System fabricated by Sloan Technology.

Spin coating under controlled vapor atmosphere was performed in a closed tank (volume ≈ 5.5 10^{-3} m\textsuperscript{3}) by placing the solvent in two Petri dishes of diameter equal to 10 cm. Spin coating was initiated only after partial saturation of the environment with the solvent vapor, and after completion of spin coating process the sample was immediately extracted from the closed tank.

In the “Rapid-Flux-Solvent-Atmosphere” (RFSA) protocol a flux of compressed air is enriched with the vapors of a solvent contained in a two necked flask and then directed inside the spin coating chamber (volume ≈ 5.5 10^{-3} m\textsuperscript{3}). The values of temperature and RH in the tank were recorded every 2s. The solutions, immediately after preparation, were drop-wise to the silicon substrate and introduced in the chamber that was immediately closed. The flux of compressed air mixed with the selected solvent vapor was switched-on and directed inside the tank, and spin coating was initiated only after a prefixed contact time (RFSA time) of the solution with the solvent vapor atmosphere. At the end of spin coating process (30 s), the sample was immediately removed from the tank and analyzed. It was checked that at any given temperature and for different kinds of solvent and RFSA operating conditions (including temperature, flow rate, delivery pressure, random fluctuation of lab atmosphere etc.) the change of RH values during the spin coating process was reproducible within 15-20 % relative error. In this study a RFSA time (contact time) of 20 s was selected, and the RH value recorded after 25 s, that is the RH value reached in the tank 5 s after starting the spin coating process, is specified.

Annealing of hybrid composites thin films was performed in air using a horizontal tube furnace (Carbolite®). The samples were heated from 25 °C to 600 °C at a rate of 2 °C min\textsuperscript{-1} and successively annealed for 4 hours at 600 °C.

Scanning electron microscopy (SEM) images were obtained with a Zeiss Ultra Plus field emission SEM at 1.5 kV (range of acceleration voltage: 0.02 kW – 30 kW) equipped with an InLens detector and a SE Everhart - Thornley Secondary Electron Detector at the CACTUS (Centro de Apoyo Científico-Tecnológico de la Universidad de Santiago de Compostela).

Atomic Force Microscopy (AFM) were obtained at room temperature by a Calibra, Veeco Instruments microscope and were performed in tapping mode. Silicon probes having a tip nominal radius of curvature of 8 nm, with a force constant of 42 N/m were used. The resonance frequency was about 320 KHz with a scan rate of 1 Hz s\textsuperscript{-1}. The sample line was 512 and the target amplitude was around 0.6 V. In order to obtain repeatable results different regions of the specimens were scanned and tests were repeated over at least 3 independent samples.

In all cases, TEM analysis was repeated on different regions of the specimens, in order to check that the morphology was truly uniform over the macroscopic area of the support. The results were confirmed also by repeating the measurements on
independent samples. Therefore, the TEM images included in the manuscript are well representative of the whole area of the support (≈1cm²).
**S2. Heat treated systems.** The thermogravimetric analysis (TGA) of the BCP was performed using a TGA Q5000 IR Thermogravimetric Analyzer of TA Instruments, in a 100 ml min$^{-1}$ N$_2$ flow atmosphere and 10 °C min$^{-1}$ heating rate. The resultant TGA curve is reported in Fig. S1. It is apparent that at $\approx$460 °C the weigh loss of the BCP is almost complete. This result indicates that the 600°C heat treatment of the hybrid composites (annealing) produces complete removal of the organic matrix.

X-rays diffraction measurements were performed with a Philips automatic powder diffractometer, using the Cu Kα (Ni-filtered) radiation ($\lambda$=0.1518 nm). The diffraction patterns were registered by a continuous scan at a rate of 0.01° ($\Delta$2θ)/1s ($\Delta$t).

![TGA curve of the PS-PEO block copolymer recorded in N$_2$ (g) atmosphere. The temperatures corresponding to 50% and $\approx$99 % weight loss are indicated.](image)

**Fig. S1.** TGA curve of the PS-PEO block copolymer recorded in N$_2$ (g) atmosphere. The temperatures corresponding to 50% and $\approx$99 % weight loss are indicated.

X-ray diffraction measurements were performed on the white powders (xerogel) recovered from the 0.0125 M TTIP, 0.0125 M H$_2$O solution (in isopropanol/toluene 1:1 vol/vol mixed solvent), by drying in air. The powders were treated at different temperatures step-wise for 4 h at 100, 400, 600, 800 °C (2 °C/min heating rate). The X-ray powder diffraction profiles of the samples recorded at room temperature before and after each annealing step are reported in Fig. S2.

![X-ray powder diffraction profiles of the samples obtained in the sol-gel process by drying the solution (0.0125 M TTIP, 0.0125 M H$_2$O, isopropanol/toluene 1:1 vol ratio mixed solvent) to obtain powders (xerogel) (a). The xerogel was annealed step by step at 400 (b), 600 (c) and 800 (d) °C. The Miller indices of anatase (c) and rutile (d) are indicated.](image)

**Fig. S2.** X-ray powder diffraction profiles of the samples obtained in the sol-gel process by drying the solution (0.0125 M TTIP, 0.0125 M H$_2$O, isopropanol/toluene 1:1 vol ratio mixed solvent) to obtain powders (xerogel) (a). The xerogel was annealed step by step at 400 (b), 600 (c) and 800 (d) °C. The Miller indices of anatase (c) and rutile (d) are indicated.

The dried powders (xerogel) did not show any Bragg peak (curve a of Fig. S2). At 400°C the reflections of anatase appear (curve b of Fig. S2). The anatase polymorph remains stable also upon successive annealing at 600°C (curve c of Fig. S2).
S2), whereas at 800 °C anatase transforms into rutile (curve d of Fig. S2). Therefore, the present analysis, in agreement with literature,\textsuperscript{31} indicates that the heat treatment at 600 °C of the hybrid nanostructured thin film of the BCP containing the titanium species produces crystalline nanoclusters of anatase.
S3. Quality of solvents. Water is a good solvent for PEO and a bad solvent for PS.\textsuperscript{52} The water solubility of PEO, in particular, is unique in this respect among the polyethers, and has been explained in terms of a delicate balance between hydrophobic (-CH\textsubscript{2}- groups) and hydrophilic interactions. The oxygen–oxygen interdistance along the PEO backbone (0.47 nm), indeed, closely matches that in the structure of water,\textsuperscript{53} so that a good structural fit between the water and the polymer is achieved.

The affinity of toluene for PS and PEO blocks of the BCP has been evaluated using the Equation (S1), valid for non polar systems:\textsuperscript{52}

\[
\chi = 0.34 + \frac{V_s (\delta_p - \delta_s)^2}{RT}
\]  

(S1)

with $\chi$ the polymer-solvent interaction parameter, 0.34 the non combinatorial entropic contribution to the mixing free energy assumed constant, $V_s$ the molar volume of the solvent, $R$ the gas constant, $T$ the temperature and $\delta$ the solubility parameter, the subscripts s and p standing for “solvent” and “polymer”, respectively. Using the values of $V_s$ and $\delta$ reported in Table S1,\textsuperscript{52} the values of $\chi =0.3$ and 0.5 for the toluene-PS and toluene-PEO pairs have been calculated at room temperature. This indicates that toluene is a good solvent of the PS block ($\chi <0.5$), and less good ($\theta$-solvent) for PEO chains.

Table S1. Molar volume ($V_s$), Hildebrand parameter ($\delta$) and polymer-solvent interaction parameter for the PS block [$\chi_{p-s}(PS)$] and for PEO block [$\chi_{p-s}(PEO)$] with toluene.

<table>
<thead>
<tr>
<th>Solvent/Polymer</th>
<th>$V_s$ (cm\textsuperscript{3}/mol)</th>
<th>$\delta$ (J cm\textsuperscript{3})\textsuperscript{1/2}</th>
<th>$\chi_{p-s}$(PS)</th>
<th>$\chi_{p-s}$(PEO)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toluene</td>
<td>106.8</td>
<td>18.2</td>
<td>0.3</td>
<td>0.5</td>
</tr>
<tr>
<td>PS</td>
<td>18.6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PEO</td>
<td>19.9</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
S4. Calculation of the degree of coverage of the titania nanoclusters on the silicon surface. In order to calculate the fractional surface area occupied by the titania nanoclusters covering the silicon substrates in the heat treated samples of the hybrid composites (degree of coverage) the corresponding FESEM images were processed with the software ImageJ, developed at the National Institutes of Health, and available free of charge at WEB site rsb.info.nih.gov/ij/. In the first step the FESEM images were converted into binary images in order to enhance the contrast (Fig. S3). In alternative, the utility Image>Adjust>Treshold was used to adjust the contrast. In the resultant images the TiO$_2$ nanoclusters appear as dark spots covering a bright field. In the dialog box Analyze>Set Measurements the toggles "Area" and "Limit to treshold" were checked. After calibration on small regions of the image where the number of dark pixels to the total number of pixels in the selected regions were manually counted, the tool Analyze>Measure was used to calculate the percentage of the area in the image occupied by the dark spots. As an example the FESEM image of Fig. 3B” relative to the heat treated hybrid composite thin films obtained by 20 s RFSA (≈45% RH) under flux of water/toluene mixed vapors is compared in Fig. S3 with the corresponding binary image. The degree of coverage of the titania nanoclusters on the silicon surface is ≈26%.

Fig. S3. FESEM image of Fig. 3B” relative to the heat treated BCP/TiO$_x$ hybrid composite thin film obtained by 20 s RFSA (≈45% RH) under flux of water/toluene mixed vapors of a toluene/isopropanol solution at $n$Ti/$n$PEO monomeric units = 40 mol % (A) and corresponding binary image obtained with ImageJ software (B).
S5. Voronoi constructions. The Voronoi constructions were used to quantify the degree of hexagonal order in the nanostructured thin films of the neat BCP and BCP/TiO₂ hybrid systems. Voronoi tesselation diagrams were created for each FESEM image denoting some kind of pseudo-hexagonal order of a motif (namely PEO cylinders and/or PEO cylinders filled with titania species and/or dot-like titania nanoclusters) by drawing bonds to connect the center of each domain (seed) to its first neighbors. The perpendicular bisectors of these bonds intersect to form a polygon, whose number of sides is equal to the number of nearest neighbors of the seed. Diagrams are thus build up in a 1:1 correspondence with the initial region of the FESEM image, in which the seed with a different coordination number have different color, for instance olive, green, red etc. for penta-, hexa-, and epta-coordinated seeds, respectively. The occasional misidentification of the coordination number for cylinders located at the edge of the image by the Voronoi algorithm was corrected by hand. Additionally, data from cylinders whose centers lay within one lattice period of the edges of the image were discarded. The final output is the sorting of the seeds identified in a FESEM image as a function of the number of its first neighboring, so that the percentage of hexa-coordinated sites (degree of hexagonal order) $R_{hexa} = \frac{N_{hexa}}{N_{tot}}$ could be extracted from the Voronoi diagrams with $N_{hexa}$ the number of hexa-coordinated seeds and $N_{tot}$ the total number of seeds.

The creation of these diagrams was possible thanks to the use of ImageJ software running a macro written by J. Hanson, Senior Imaging Analyst at Eli Lilly and Company. This algorithm worked efficiently on FESEM images of 1μm X 1μm, that were analyzed starting from the FESEM images of Fig. 1 and 3. As an example, the Voronoi diagrams of the neat BCP is shown in Fig. S4. The values of $R_{hexa}$ are the results of averaging on different regions of the same specimens, and for each sample on specimens prepared independently with the same protocol.

Fig. S4. A: Voronoi constructions preformed on 1μm x 1μm FESEM images of the neat BCP thin films prepared by spin-coating in ambient atmosphere B: Legend highlighting the correspondences between colors and number of the sides of the polygons that can be drawn around each seed (cylindrical PEO domains) in the Voronoi construction A. The degree of hexagonal order $R_{hexa}$ evaluated with help of the Voronoi diagram in A is indicated.
S6. Radial profile analysis of FFT-FESEM images. The long range order of nanostructures achieved in our systems was sampled by radially averaging the two-dimensional Fast Fourier Transform of the corresponding FESEM images shown in the insets of Fig. 1,3. The so obtained radial intensity distribution curves are shown in Fig. 2A. In all cases a correlation peak is present with a maximum at a radial distance inversely related to the correlation distance of first neighboring PEO domains.

In the case of nanostructured thin-films obtained by spin coating in ambient atmosphere (curves a,d of Fig. 2A) the correlation peak of the radially averaged spectral intensity is broad indicating a liquid-like arrangement of PEO cylinders in the PS matrix. In the hybrid composite at 40 mol% Ti (curve d of Fig. 2A) the correlation peak is broader than that of neat BCP (curve a of Fig. 2A) reflecting the formation of worm-like PEO domains in the corresponding thin films (Fig. 1C).

In the case of the nanostructured thin films prepared by spin coating in controlled solvent vapor atmosphere, good lateral order is achieved only in the case of the neat BCP upon 30 min contact time of the solution with water/toluene vapors (62 % RH, Fig. 1D), as indicated by the presence of a second order maximum in the corresponding radial intensity profile (curve b of Fig. 2A). The hybrid system with 40 mol% Ti does not benefit from this treatment regardless of contact time (3 and 30 min) of the solution with water/toluene vapors in the closed spin-coating tank, (curves c, f of Fig. 2A) due to occurrence of reactions of hydrolysis and condensation of TTIP that start immediately after dissolution of TTIP since, in the prolonged protocol for preparation of the thin film, these reactions significantly overwhelm the self-assembly of the BCP.

The quick RFSA protocol of 20 s contact time of the solution with a flux of water/toluene mixed vapors is beneficial not only to the self-assembly of neat BCP that shows a narrow correlation peak flanked by a second and third order peak in the radial intensity distribution (curve c of Fig. 2A and Fig. 3B), but also to the self-assembly of the hybrid BCP solution containing 40 mol% Ti (Fig. 3B'), whose radial intensity distribution show a sharp correlation peak of width comparable to that of the neat BCP nanostructure prepared under the same conditions (compare curves c and g of Fig. 2A).
S7. Distribution of the height of TiO₂ nanopillars. The height distribution of TiO₂ nanopillars in substrates (whose typical SEM image is shown in Fig. 3B”) obtained by annealing the hybrid system containing 40mol% Ti, prepared under RFSA protocol, is displayed in Fig. S5. The distribution has been extracted from the the corresponding AFM height images of three independent samples, by manually measuring the height of about one hundred nanopillars for each image. The distribution was fitted to a Gauss function, centered at height of 10 ± 2 nm, as shown in Fig. S5.

**Fig. S5.** Height distribution of TiO₂ nanopillars extracted from AFM height images of TiO₂ substrates obtained by annealing (600°C at a rate of 2 °C min⁻¹ for 4h) RFSA hybrid composites with 40 mol% Ti. In the RFSA protocol spin coating was applied for 30 s under flux of water/toluene vapors at 1:1 vol ratio after 20 s contact time at ≈45% RH as in Fig. 3B’.

Notes and references

a Dipartimento di Ingegneria Chimica, dei Materiali e della Produzione Industriale, Università di Napoli Federico II, Piazzale Tecchio 80, 80125 Naples, Italy.
b Dipartimento di Scienze Chimiche, Università di Napoli Federico II, Complesso Monte Sant’Angelo, via Cintia, 80126, Napoli, Italy. E-Mail: finizia.auriemma@unina.it; Phone: +39 081 674341; Fax: +39 081 674090.
c Centre for Research in Biological Chemistry and Molecular Materials (CIQU), University of Santiago de Compostela, 15782, Santiago de Compostela, Spain.

